
آموزش فارسی افتر افکت متحرک سازی متن
)CS6 نسخه این آموزش و توصیه شده( CS4  :نسخه های قابل اجرا

مدت زمان تکمیل: 2 ساعت
سطح آموزش: متوسط-پیشرفته

مترجم، تهیه و تنظیم: فرشاد زرین

در نرم افزار افتر افکت راه های مختلفی برای متحرک سازی متن وجود دارد. شما می توانید لایه های متنی را بصورت دستی 
از طریق ساخت فریم های کلیدی در پانل Timeline و یا انیمشین های از پیش ساخته شده ایجاد نمایید. شما حتی می توانید 
تنها یک یا چند حرف را بصورت جداگانه در لایه متنی متحرک کنید. در این آموزش شما با استفاده از تکنیک های مختلف چند 

لایه متنی را دارای انیمیشن های مختلف می کنید.
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1. پس از دانلود فایل های پروژه و خارج کردن آن از حالت فشرده پوشه Lesson03 را در محل مناسب کپی نمایید. 

 Close نمایش داده خواهد شد. روی دکمه Welcome را باز نمایید. پنجره خوشامد گویی Adobe After Effects 2. نرم افزار
کلیک نمایید.

lesson03. فایل را با نام Lesson03/Finished_Project را انتخاب نمایید.  در پوشه Save As گزینه File > Save As از منوی
aep ذخیره نمایید.

Lesson03/ در مسیر Assets وارد پوشه Import File دابل کلیک کرده و سپس در کادر Project 3. در ناحیه خالی پانل
Assets شوید. فایل های Lotus.swf و pondbackground.mov را انتخاب کرده و روی دکمه Open کلیک کنید.

4. کلید های Ctrl+N را فشار داده تا کادر محاوره ای ساخت ترکیب جدید Composition Settings باز شود. در کادر متنی 
Composition Name نام ترکیب را Pont_Title_Sequence وارد کرده، از فهرست Preset گزینه NTSC DV و مدت زمان 

پروژه را هم در کادر Duration به 10 ثانیه تغییر دهید. در نهایت روی OK کلیک نمایید. 
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توجه: NTSC رزولوشن استاندارد تلویزیون در کشور آمریکا می باشد. برای سایر کشور ها از استاندارد PAL می توانید 
استفاده کنید.

5. فایل های pondbackground.mov و Louts.swf را از پانل Project به پانل Timeline درگ نمایید. لایه Lotus.swf را 
در بالای لایه pondbackground.mov قرار دهید.

6. در حالیکه که لایه Lotus انتخاب شده است، کلید S را فشار داده تا ویژگی Scale تغییر اندازه لایه نمایان شود. مقدار 
یکی از اندازه های افقی و یا عمودی را به %30 تغییر دهید. بدلیل اینکه این اندازه ها به یکدیگر متصل شده اند مقدار 

دیگر هم تغییر خواهد کرد.
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به   Timeline پانل  در  را  موقعیت  مقادیر  شود.  نمایان   Position لایه  موقعیت  تغییر  ویژگی  تا  داده  فشار  را   P کلید   .7
170,250 تغییر دهید. شکل گل در پایین صفحه قرار خواهد گرفت. کلید های Ctrl+S را فشار داده تا پروژه تا اینجای کار 

ذخیره شود.

» نکته آموزشی شماره 1: در نرم افزار افتر افکت می توانید با انعطاف پذیری و دقت لایه های متنی را اضافه کنید. شما می 
توانید متون را به طور مستقیم روی صفحه در پانل Composition ایجاد کرده و به سرعت نوع فونت، استایل، اندازه و رنگ 
متن را تغییر دهید. همچنین می توانید متون افقی و عمودی را در هر جای پانل Composition اضافه کنید. پانل های ابزار، 
کاراکتر و پاراگراف شامل ابزار های متنی بسیار مختلفی می باشند. شما می توانید تغییرات را روی قسمتی از متن و یا تمام 
پاراگراف از نظر تراز بندی و تنظیم فاصله خطوط انجام دهید. به علاوه نرم افزار افتر افکت تنظیمات مختلفی را برای متحرک 

سازی به آسانی در اختیار شما قرار می دهد.
نرم افزار افتر افکت 2 حالت متنی مختلف دارد: حالت point text که برای ایجاد یک کلمه متنی و یا یک خط متن استفاده می 

شود و حالت paragraph text که برای ساخت متون پاراگراف و چند خطی مورد استفاده قرار می گیرد.
مثل دیگر لایه ها در نرم افزار افتر افکت شما می توانید لایه های متنی را متحرک کنید، افکت به آن ها اضافه کرده و یا آن 

ها را تبدیل به لایه های متنی سه بعدی کرده و در نماهای پرسپکتیو نمایش دهید. «

ساخت و قالب بندی متن نقطه ای:

8. ابزار Horizontal Type را از پانل ابزار انتخاب کنید. در هر نقطه ای از پانل Composition که مایلید کلیک کرده و کلمه 
مورد نظر خود را تایپ نمایید. << توجه: برای تایپ فارسی باید از نرم افزار های فارسی نویس استفاده نمایید.<<

کلید Enter قسمت اعداد ماشین حسابی صفحه کلید را فشار داده و یا لایه متنی را در پانل Timeline انتخاب کرده تا از 
حالت ویرایش متن خارج شوید.

» نکته آموزشی شماره 2: فشار دادن کلید Enter اصلی صفحه کلید باعث ساخت یک خط و پاراگراف متنی می شود. «
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:Character استفاده از پانل
9. از منوی Window > Workspace گزینه Text را انتخاب کرده تا تنها پانل هایی که برای کار با متون هستند نمایش داده 

شوند.

Bold ضخیم از  Myriad Pro را با حالت  Character اگر کلمه تایپ شده با حروف انگلیسی می باشد، فونت  10. در پانل 
فهرست فونت ها انتخاب نمایید. اگر این فونت در کامپیوتر شما نصب نیست از فونتی دیگر با حالت ضخیم استفاده نمایید. 

اندازه قلم را هم به 72 پیکسل تغییر دهید. مابقی تنظیمات را در حالت پیش فرض باقی نگه دارید.

» نکته آموزشی شماره 3: پانل Paragraph: با استفاده از پانل paragraph تنظیمات مختلفی را می توانید روی پاراگراف متن 
انجام دهید. تنظیماتی نظیر: تراز بندی، تور رفتگی و میزان جدا سازی سطر های پاراگراف. در حالت متن نقطه ای هر خط یک 
Paragraph برای قالب بندی یک پاراگراف، چند پاراگراف و تمام پاراگراف ها  پاراگراف می باشد. شما می توانید از پانل 

استفاده نمایید. «

:Paragraph استفاده از پانل
11. در این پروژه تنها یک ویژگی در پانل Paragraph را تغییر می دهیم. در پانل پاراگراف روی دکمه Center Text کلیک 

نمایید. این حالت متن را در مرکز لایه قرار می دهد.  مابقی تنظیمات را در حالت پیش فرض باقی نگه دارید.
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تغییر موقعیت متن:
12. لایه متنی را در پانل Timeline انتخاب کنید.

13. از منوی Layer > Transform گزینه Fit To Comp Width را انتخاب نمایید. انتخاب این گزینه باعث می شود اندازه 
لایه متنی با عرض صفحه کاری برابر شود.

                       Selection را انتخاب نمایید. بوسیله ابزار انتخاب Snap To Grid و سپس گزینه Show Grid ابتدا گزینه View 14. از منوی
لایه متنی را بصورت عمودی روی خط افقی مرکز صفحه درگ نمایید. هنگام درگ کردن کلید Shift را پایین نگه داشته تا لایه 

 :Selection متنی جابجا نشود. ابزار

 Window > Workspace را انتخاب کرده تا خطوط شبکه ای مخفی شوند. سپس از منوی Show Grid گزینه View 15. از منوی
گزینه Standard را انتخاب کرده تا محیط کاری به حالت استاندارد بازگردد. از منوی File گزینه Save را انتخاب کرده تا پروژه 

ذخیره شود.

متحرک سازی متن و استفاده از افکت های پیش فرض:

16. لایه متنی را در پانل Timeline انتخاب کنید. از منوی Animation گزینه Broswe Presets را انتخاب نمایید. برنامه 
Bridge پوشه های افکت های پیش فرض  افتر افکت را نمایش می دهد. 

در پانل Content ابتدا روی پوشه Text و سپس روی پوشه Blurs دابل کلیک کنید. با انتخاب هر یک از افکت ها پیش 
نمایش آن در پانل Preview پخش خواهد شد.

17. افکت Evaporate را انتخاب کرده، پیش نمایش آن را مشاهده کرده و سپس روی آن دابل کلیک کرده تا افکت به لایه 
متنی اعمال شود. برنامه Bridge را باز نگه دارید، در ادامه پروژه از آن استفاده خواهیم کرد.
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پیش نمایش محدوده ای از فریم ها:
18. در پانل Timeline نشان گر زمان جاری روی ثانیه 3:00 قرار دهید. کلید N را فشار داده تا پایان کروشه محدوده کاری 

روی ثانیه 3 قرار بگیرد.

19. کلید 0 قسمت اعداد ماشین حسابی صفحه کلید را فشار داده و یا روی دکمه RAM Preview در پانل Preview کلیک 
نمایید. حروف کلمه در ابتدا نمایش داده می شوند و سپس در پس زمینه بخار می شوند. در این پروژه ما می خواهیم این 
افکت برعکس نمایش داده شود، یعنی ابتدا حروف بخار شوند و سپس در صفحه نمایش داده شود. در ادامه این تغییر را 

انجام خواهیم داد.
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20. کلید Space صفحه کلید را فشار داده تا پیش نمایش پروژه متوقف شود. کلید Home صفحه کلید را فشار داده تا نشان 
گر زمان جاری به زمان 0:00 بازگردد.

سفارشی کردن یک انیمیشن:
21. لایه متنی را در پانل Timeline انتخاب نمایید. کلید U صفحه کلید را فشار دهید. فشار دادن کلید U باعث می شود 

تمام تنظیمات متحرک شده نمایش داده شوند.

22. روی ویژگی Offset کلیک کرده تا هر دو فریم کلیدی آن انتخاب شوند. ویژگی Offset مشخص می کند انیمیشن در چه 
مدت زمانی شروع و به پایان می رسد. 

23. از منوی Animation > Keyframe Assistant گزینه Time-Reverse Keyframes را انتخاب نمایید. انتخاب این گزینه 
باعث می شود ابتدا و انتهای انیمیشن برعکس شود.

نشان گر زمان را بصورت دستی از زمان ثانیه 0 تا 3 درگ کنید. انیمیشن حروف ابتدا بخار می شوند و سپس نمایان می شود.

24. کلید U را فشار دهید تا تنظیمات لایه مخفی شود. کلید End را فشار داده تا نشان دهنده زمان جاری در انتهای خط کش 
 Ctrl+S را فشار دهید تا کروشه انتهایی در پایان محدوده کاری تنظیم شود. با فشار دادن کلید های N زمان قرار بگیرد. کلید

تنپروژه را تا اینجای کار ذخیره نمایید.
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متحرک سازی با فریم های کلیدی تغییر اندازه:

 S نشان دهنده زمان جاری را روی ثانیه 3:00 قرار دهید. لایه متنی را انتخاب کرده و سپس کلید Timeline 25. در پانل
را فشار داده تا ویژگی تغییر اندازه لایه نمایان شود. روی آیکون کرونومتر Scale کلیک کرده تا فریم کلیدی در زمان جاری 

ایجاد شود.
نشان دهنده زمان را جاری روی ثانیه 5:00 قرار دهید. اندازه لایه را به %100,100 تغییر دهید. نرم افزار افتر افکت 

فریم کلیدی دوم را ایجاد خواهد کرد.
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پانل  در  تنظیم شود.  کاری  محدوده  پایان  تا  را فشار   N کلید  کنید.  5:10 درگ  ثانیه  به  را  جاری  زمان  نشان دهنده   .26
Preview روی دکمه RAM Preview کلیک کرده تا انیمیشن را مشاهده کنید. اندازه متن از ثانیه 5:00 تا 5:10 کوچکتر می 

شود. کلید Space را فشار داده تا پیش نمایش متوقف شود.

:Easy Ease اضافه کردن حرکت آرام انیمیشن
27. ابتدا و انتهای انیمیشن متن بصورت ناگهانی شروع و پایان می یابد. با استفاده از ویژگی Easy Ease این حالت را به 

آرامی نمایش می دهیم.
Easy Ease Out را  Keyframe Assistant گزینه  Scale راست کلیک کرده و از فهرست  ابتدایی ویژگی  روی فریم کلیدی 

www.faانتخاب نمایید. 
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 Keyframe را از فهرست Easy Ease In در ثانیه 5:00 راست کلیک کرده و این بار گزینه Scale 28. روی فریم کلیدی ویژگی
Assistant انتخاب نمایید.

انیمیشن را در حالت RAM Preview پیش نمایش کنید و تغییر را مشاهده کنید. کلید Space را برای توقف انیمیشن فشار 
دهید.

با فشار دادن کلید های Ctrl+S پروژه را تا این مرحله ذخیره کنید.

:)parenting( متحرک سازی با استفاده از رابطه خویشاوندی

29. در این مرحله می خواهیم انیمیشن تغییر اندازه متن را به گل لوتوس اعمال کنیم. این کار را می توانیم بصورت جداگانه 
انجام دهیم، اما راه بهتر استفاده از رابطه خویشاوندی می باشد که بسیار آسان می توان انیمیشن یک لایه را به لایه دیگر با 
همان تنظیمات اعمال کرد. کلید Home را فشار داده تا  در ابتدای خط کش زمان قرار بگیرد. در پانل Timeline از فهرست 
Parent گزینه شماره 1 که در واقع همان لایه متنی می باشد را انتخاب کنید. حال لایه متنی پدر لایه گل و لایه گل با توجه 

به اینکه تنظیمات آن را گرفته است فرزند آن می شود.

30. بصورت دستی نشان دهنده زمان را از زمان 3:00 تا  5:00 پیش نمایش کنید. هر دو لایه متن و گل در مدت زمان 
مشخص تغییر اندازه می شوند.
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34. ترکیب credits را از پانل Project به بالای تمام لایه های Timeline درگ نمایید.

35. متن لایه ی فتوشاپی که وارد کرده ایم قابل ویرایش نمی باشد. برای این کار باید آن را تبدیل به متن از نوع قابل 
ویرایش بکنیم. روی ترکیب credits در پانل Project دابل کلیک کرده تا محتویات آن در پانل Timeline خودش باز شود. 

 Convert گزینه Layer انتخاب نمایید. از منوی Timeline را پایین نگه داشته و هر دو لایه فتوشاپی را در پانل Shift کلید
To Editable Text را انتخاب نمایید. اگر کادر هشدار فونت نمایش داده شد روی OK کلیک نمایید. 

روی لایه شماره 2 در پانل Composition دابل کلیک کرده تا ابزار Horizontal Type بصورت اتوماتیک فعال شود. متن 
لایه را به کلمه دلخواه تغییر دهید.

31. کلید Home را فشار داده تا به زمان 0:00 باز گردید. کروشه انتهایی ناحیه کاری را تا پایان خط کش زمان درگ نمایید. 
لایه متنی را در پانل Timeline انتخاب کرده و با فشار دادن کلید S ویژگی Scale آن را مخفی کنید. با فشار دادن کلید های 

Ctrl+S پروژه را تا اینجای کار ذخیره کنید.

» نکته آموزشی شماره 4: درباره لایه های پدر و فرزند: لایه پدر به معنای اعمال تغییرات لایه به لایه ای دیگر که لایه فرزند 
نامیده می شود، می باشد. ایجاد رابطه بین لایه ها تغییرات در لایه پدر را روی لایه فرزند )به جز مقدار Opacity( همگام می 
سازد. به عنوان مثال اگر لایه پدر 5 پیکسل از مکان خودش به سمت راست حرکت کند لایه فرزند هم 5 پیکسل از مکان 
خودش به سمت راست حرکت می کند. یک لایه تنها می تواند یک پدر داشته باشد، اما خود لایه می تواند پدر هر تعداد لایه 
2 بعدی و 3 بعدی در یک ترکیب باشد. ایجاد رابطه خویشاوندی بین لایه ها برای ساخت انیمیشن های پیچیده نظیر اتصال 

حرکات عروسک خیمه شب بازی و یا نمایش حرکت چرخش سیاره ها در منظومه شمسی کاربردی می باشد. «

وارد کردن متن:

32. در ناحیه خالی پانل Project دابل کلیک کرده تا کادر مربوط  به وارد کردن فایل باز شود. فایل فتوشاپ credits.psd را از 
 Composition - Retain گزینه Import As انتخاب کرده و از فهرست Lesson03/Assets پوشه فایل های مورد نیاز پروژه

Layer Size را انتخاب و روی دکمه Open کلیک نمایید.

33. در کادر محاوره ای credits.psd گزینه Editable Layer Styles را انتخاب کنید و روی OK کلیک نمایید.

<<تصویر در صفحه بعدی
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36. با انتخاب ابزار Selection           از حالت ویرایش متن خارج شوید. با پایین نگه داشتن کلید Shift هر دولایه متنی را 
در پانل Timeline انتخاب کنید. در صورت بسته بودن پانل Character آن را از منوی Window > Character باز نمایید. 

فونت Myriad Pro را در حالت Bold برای هر دو متن انتخاب نمایید.

» نکته آموزشی شماره 5: نام لایه متنی با تغییر محتوای آن تغییر نخواهد کرد. بدلیل اینکه نام اصلی لایه در نرم افزار 
فتوشاپ ایجاد شده است. برای تغییر نام لایه، آن را انتخاب و کلید Enter را فشار دهید. نام لایه را تغییر و سپس کلید 

Enter را دوباره فشار دهید. «

متحرک سازی متون:

37. در پانل Timeline به زمان ثانیه 5:00 بروید. در این زمان عنوان اصلی متن و گل لوتوس به تغییر اندازه نهایی خود می 
رسند. لایه متنی شماره 2 را در پانل Timeline انتخاب نمایید. 

کلید های Ctrl+Alt+Shift+O را فشار داده تا برنامه Adobe Bridge باز شود.

 Fade Up Characters بروید. افکت متنی Presets > Text > Animate In از طریق مسیر Animate In 38. به داخل پوشه
را انتخاب و روی آن دابل کلیک نمایید. افکت انیمیشن به لایه متنی اعمال خواهد شد.

<<تصویر در صفحه بعدی
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39. در حالی که لایه شماره 2 همچنان انتخاب شده است 2 بار پشت سر هم کلید حرف U صفحه کلید را فشار دهید. تنظیمات 
مربوط به انیمیشن نمایش داده خواهد شد. 2 فریم کلیدی یکی در ثانیه 5 و یکی دیگر در ثانیه 7 مشاهده خواهید کرد. ما 

می خواهیم با کاهش 1 ثانیه ای انیمیشن سرعت نمایش آن را سریع تر کنیم.

40. به زمان ثانیه 6:00 بروید. فریم کلیدی دوم را به ثانیه 6 درگ نمایید. حال می توانید نشان دهنده زمان را بین ثانیه 5 
و 6 درگ کرده تا انیمیشن افکت متن را مشاهده کنید.

41. بعد از انجام تغییرات کلید U را فشار داده تا تنظیمات انیمیشن مخفی شود. کلید های Ctrl+S را فشار داده و پروژه را 
تا اینجای کار ذخیره نمایید.

متحرک سازی متن با استفاده از انیمشین های مسیر:
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42. زبانه Pond_Title_Sequence را در پانل Timeline انتخاب نمایید. تمام لایه ها را از حالت انتخاب خارج کرده و به ثانیه 
5:00 بروید.

 Presets > از طریق مسیر Paths باز شود. به پوشه Adobe Bridge را فشار داده تا برنامه Ctrl+Alt+Shift+O کلید های
Text > Paths بروید. روی انیمیشن Pipes دابل کلیک نمایید. بصورت خودکار به نرم افزار افتر افکت باز خواهید گشت. 

نرم افزار افتر افکت یک لایه متنی همراه با مسیری شبیه حرف S در پانل Timeline و Composition ایجاد خواهد کرد.

43. در پانل Timeline به زمان ثانیه 6:05 بروید. در این زمان کلمه pipes بصورت کامل و افقی روی صفحه مشخص است.

44. روی لایه pipes در پانل Timeline دابل کلیک کرده تا نرم افزار افتر افکت بصورت خودکار ابزار Horizontal Typeو  
کلمه pipes را در پانل Timeline انتخاب نماید.

کلمه مورد نظر خود را تایپ کنید. در این آموزش کلمه Directed By تایپ شده است. کلید Enter قسمت کلید های ماشین 
حسابی صفحه کلید را فشار دهید. افتر افکت نام لایه را در پانل Timeline بروز می کند.

45. در پانل Character فونت را به Minion Pro و یا فونت دلخواه تغییر دهید. استایل فونت را به Regular و اندازه آن 
را به px 20 تغییر دهید. مابقی تنظیمات را در حالت پیش فرض باقی نگه دارید.

<<تصویر در صفحه بعدی
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46. نشان دهنده زمان جاری را از ثانیه 5 تا 8 درگ کرده تا مشاهده کنید که کلمه به چه صورت  در صفحه نمایش داده می 
شود.

ابزار Selection را انتخاب کرده و سپس روی مسیر در پانل Composition دابل کلیک نمایید. مسیر را به طرف پایین درگ 
کرده تا زمانی که نوشته عنوان اصلی در مرکز ناحیه بالایی مسیر قرار بگیرد. )همانند تصویر زیر(.

بعد از انجام تغییرات کلید Enter را فشار دهید.

47. با فشار دادن کلید های Ctrl+S پروژه را تا اینجای کار ذخیره کنید.

متحرک سازی مسیر متن:
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متن  ابزار  کنید.  انتخاب  چپ(  سمت  در  )کلمه  را   1 شماره  لایه  کنید.  کلیک   Credits زبانه  روی   Timeline پانل  در   .48
Horizontal Type را انتخاب کرده و سپس متن لایه را به 2 یا 3 کلمه دلخواه تغییر دهید. بین کلمات فاصله قرار دهید. 

بعد از تغییر روی نام لایه کلیک کنید.

 Increase Tracking واژه Effects & Presets 49. به زمان 7:10 بروید. لایه ی متنی را که تغییر دادید انتخاب کنید. در پانل
را در کار جستجوی افکت تایپ نمایید. سپس روی افکت Increase Tracking دابل کلیک کرده تا به لایه متنی اعمال شود.

50. نشان دهنده زمان را از زمان 7:10 تا 9:10 بصورت دستی درگ کرده تا انیمیشن متن را مشاهده کنید.

51. در این مرحله می خواهیم انیمیشن افکت را سفارشی سازی کنیم. طوری که در ابتدای انیمیشن حروف بهم چسبیده و 
روی هم قرار گرفته باشند و سپس در ادامه در فاصله مشخصی از یکدیگر جدا شوند. 

لایه متنی را که انیمیشن به آن اعمال کردید انتخاب کنید. کلید U صفحه کلید را 2بار پشت سر هم فشار دهید تا تنظیمات 
انیمیشن نمایش داده شود.

به زمان 7:10 بروید.

52. در زیر قسمت Animator 1 مقدار Tracking Amount را به 5- تغییر دهید تا حروف به یکدیگر بچسبند.
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53. روی فلِش فریم کلیدی قسمت Tracking Amount کلیک کرده و سپس مقدار Tracking Amount را به 0 تغییر دهید. 
نشان دهنده زمان را بصورت دستی از زمان 7:10 تا 9:10 درگ کرده تا تغییرات در انیمیشن مشاهده کنید.

متحرک سازی شفافیت متن:

54. لایه ی متنی شماره 1 را در پانل Timeline ترکیب Credits انتخاب کنید. 
کلید T را فشار داده تا ویژگی Opacity متن نمایان شود.

به زمان 7:10 بروید و مقدار Opacity را به %0 تغییر دهید. سپس روی آیکون کرونومتر کلیک کرده تا فریم کلیدی ایجاد 
شود.

به زمان 7:20 بروید. مقدار Opacity را به %100 تغییر دهید. فریم کلیدی بصورت خودکار ایجاد خواهد شد. انیمیشن 
شفافیت حروف در مدت زمان مورد نظر ایجاد شد.

55. نشان دهنده زمان را از ثانیه 7:10 تا 8:10 درگ کرده تا انیمیشن شفافیت و جدا شدن حروف را مشاهده کنید. 
 Easy Ease گزینه Keyframe Assistant راست کلیک کرده و از فهرست باز شده Opacity روی فریم کلیدی دوم انیمیشن

In را انتخاب کنید.
با فشار دادن کلید های Ctrl+S پروژه را تا اینجای کار ذخیره کنید.
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استفاده از گروه متحرک ساز متن:

گروه متحرک ساز متن به شما اجازه می دهد که حروف را بصورت جداگانه در یک کلمه متحرک کنید.

» نکته آموزشی شماره 6: گروه متحرک ساز متن شامل یک یا چند انتخاب کننده و همچنین شامل یک یا چند ویژگی متحرک 
ساز می باشد. انتخاب کننده همانند یک ماسک عمل می کند که مشخص می کند کدام یک از کاراکتر ها یا قسمتی از متن می 
خواهند متحرک شوند. با استفاده از انتخاب کننده شما می توانید محدوده مورد نظر و یا تعداد حروف را برای متحرک سازی 

در یک کلمه مشخص کنید. 
با ترکیب انتخاب کننده ها و ویژگی های متحرک ساز شما می توانید انیمیشن های پیچیده متنی بسازید، در غیر اینصورت این 
کار نیاز به زحمت زیادی دارد که باید با فریم های کلیدی آن را انجام دهید. در نتیجه متحرک ساز های متن از تعداد کمی از 

فریم های کلیدی حتی در انیمیشن های پیچیده استفاده می کنند. «

برای اطلاعات بیشتر درباره گروه متحرک ساز متن به بخش کمک )Help( نرم افزار افتر افکت مراجعه کنید.

56. در پانل Timeline به زمان 8:10 بروید. ویژگی Opacity را برای لایه متنی مخفی کنید. سپس بخش تنظیمات Text لایه 
متنی شماره 1 را باز کنید.

در سمت راست کلمه Text روی آیکون Animate کلیک کرده تا فهرست باز شو نمایش داده شود. از این فهرست گزینه 
Skew را انتخاب نمایید. گروه تنظیمات جدیدی به نام Animator 2 نمایش داده می شود.

 Enter تغییر دهید. کلید Skew Animator را فشار دهید. نام آن را به Enter را انتخاب کرده و کلید Animator 2 57. گروه
را مجدداً فشار دهید.

58. بخش Skew Animator را باز کنید تا تنظیمات نمایان شود. )تصویر بالا(. 
در پانل Composition انتخاب کننده ی ویژگی Skew را در سمت چپ روی حرف اول کلمه دوم درگ کنید. )همانند تصویر 

زیر.( انتخاب کننده دارای علامت مثلث و خط عمودی می باشد.
<<تصویر در صفحه بعدی
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59. حال علامت انتخاب کننده ی Skew را در سمت راست روی حرف آخر کلمه دوم درگ نمایید. در این آموزش انتخاب کننده 
اول در سمت چپ حرف W و انتخاب کننده دوم در سمت راست حرف b قرار دارد.

60. شما می توانید با تغییر مقدار Skew حالت تغییر کج شدن کلمه را به سمت راست و چپ مشاهده کنید. مطمئن شوید 
مقدار Skew در بخش Skew Animator روی 0 قرار دارد. به زمان 8:05 بروید و روی آیکون کرونومتر      کلیک کنید تا 

اولین فریم کلیدی ایجاد شود. 

61. به زمان 8:08 بروید. مقدار Skew را به 50 تغییر دهید. افتر افکت فریم کلیدی بعدی را ایجاد می کند.

62. به زمان 8:15 بروید. مقدار Skew را به 50- تغییر دهید. افتر افکت یک فریم کلیدی دیگر را ایجاد می کند.

<<تصویر در صفحه بعدی
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<<تصویر در صفحه بعدی

63. به زمان 8:20 بروید. مقدار Skew را به 0 تغییر دهید تا فریم کلیدی آخر ساخته شود.

 Animation > Keyframe انتخاب شوند. سپس از منوی Skew کلیک کرده تا تمام فریم های کلیدی Skew 64. روی ویژگی
Assistant گزینه Easy Ease را انتخاب کنید.

نشان دهنده زمان را از 7:10 تا 8:20 بصورت دستی درگ کرده تا حالت انیمیشن حرکت کلمه را که به سمت چپ و راست 
کشیده می شود، مشاهده کنید.

65. تنظیمات مربوط به انمیشین لایه شماره 1 را مخفی کنید. 
زبانه Pond_Title_Sequence را در پانل Timeline انتخاب کرده تا به ترکیب اصلی بازگردید. کلید Home را فشارداده تا 
تا ابتدای زمان پروژه بازگردید. در پانل Preview روی آیکون RAM Preview کلیک کرده تا تمام انمیشین را بصورت پیش 

نمایش مشاهده کنید.
کلید Space صفحه کلید را فشار داده تا پیش متوقف شود. از منوی File گزینه Save را انتخاب کرده تا پروژه ذخیره شود.

» نکته آموزشی شماره 7:برای حذف تمام متحرک ساز های متن لایه متنی مورد نظر را در پانل Timeline انتخاب کرده و سپس 
از منوی Animation گزینه Remove All Animators را انتخاب نمایید. «

پاک سازی مسیر انیمیشن:

آیکون  روی  شود.  نمایان  آن  انیمیشن  تنظیمات  تا  داده  فشار  را   U کلید  نمایید.  انتخاب  را   Directed By کلمه  لایه   .66
کرونومتر ویژگی Offset کلیک کرده تا تمام فریم های کلیدی آن حذف شود.

باتوجه به موقعیتی که نشان دهنده ی زمان در خط کش زمان دارد مقدار Offset شاید و شاید هم نه روی %0 نباشد. اگر 
این مقدار %0 نیست آن را به %0 تغییر دهید.
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67. آخرین فریم کلیدی را برای ویژگی Margin در پانل Timeline انتخاب کرده و با فشار دادن کلید Delete آن را حذف 
نمایید.

68. به زمان 6:14 بروید و مقدار Margin را به 685 تغییر دهید.

69. ابزار Selection را انتخاب کنید. در پانل Composition نقطه بالایی و سمت راست شکل مسیر را با پایین نگه داشتن 
کلید Shift به خارج از صفحه درگ نمایید. 

سپس نقطه پایینی و سمت چپ مسیر را هم به بیرون از صفحه کاری درگ نمایید. در ادامه ما می خواهیم یک سنجاقک به 
انیمیشن اضافه کنیم. این کار باعث می شود در لحظه ورود و خروج سنجاقک در صحنه اصلی قرار نداشته باشد.
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 Mask Path ویژگی M انتخاب کرده و با فشار دادن کلید Timeline را در پانل directed by 73. به زمان 5:00 بروید. لایه
لایه را نمایان کنید.

ویژگی Mask Path را انتخاب کرده و از منوی Edit گزینه Copy را انتخاب نمایید.
لایه dragonfly را انتخاب کرده و با فشار دادن کلید P ویژگی Position لایه را نمایان کنید.

ویژگی Position را انتخاب کرده و سپس از منوی Edit گزینه Paste را انتخاب نمایید.
نرم افزار افتر افکت فریم های کلیدی موقعیت لایه Directed by روی لایه dragon fly قرار می دهد.

74. در حالیکه لایه dragonfly انتخاب شده است، از منوی Layer > Transform گزینه Auto-Oreint را انتخاب نمایید. در 
کادر Auto-Oreintaion گزینه Oreint Along Path را انتخاب نمایید. روی OK کلیک نمایید.

حال سنجاقک در جهت رو به جلو حرکت می کند.
لایه dragonfly را انتخاب کرده و با فشار دادن کلید P ویژگی Position را مخفی کنید.

<<تصویر در صفحه بعدی

70. با توجه به مقداری که شما نقاط را از صفحه خارج کردید ممکن است مجدداً نیاز داشته باشید مقدار Margin را تغییر 
دهید. 

انیمیشن را از زمان 5:00 تا 6:20 پیش نمایش کنید تا حرکت کلمه را روی متن مشاهده کنید. اگر کلمه به درستی روی گل 
لوتوس قرار نمی گیرد مقدار First Margin آن را دوبار ه تنظیم کنید. 

تمامی تنظیمات مربوط به لایه را مخفی کرده و با فشار دادن کلید های Ctrl+S پروژه را تا اینجای کار ذخیره نمایید.

متحرک سازی یک لایه غیر متنی روی متن:

71. روی ناحیه خالی پانل Project دابل کلیک کرده تا کادر محاوره ای Import File باز شود. در پوشه فایل های تمرین )پوشه 
Assets( فایل dragonfly.ai را انتخاب کرده و از فهرست Import As گزینه Composition - Retain Layer Size را انتخاب 

نمایید. سپس روی دکمه Open کلیک نمایید.

72. ترکیب dragonfly را از پانل Project به بالای لایه ها در پانل Timeline درگ نمایید.
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75. در این مرحله می خواهیم زمان بندی حرکت متن و سنجاقک را هماهنگ کنیم. 
لایه Directed by را انتخاب کرده و کلید U صفحه کلید را فشار دهید تا تنظیمات انیمیشن آن نمایش داده شود.

به زمان 5:18 بروید و مقدار Fisrt Margin را به 373 تغییر دهید. نرم افزار افتر افکت فریم کلیدی را اضافه می کند. حال 
متن پشت سنجاقک حرکت می کند.

به زمان 5:25 بروید و مقدار First Margin را به 559 تغییر دهید.
به زمان 4:24 بروید و اولین فریم کلیدی First Margin را در این مکان درگ نمایید.

76. بصورت دستی انیمیشن را از زمان 4:20 تا 7:10 پیش نمایش کنید. کلمه سنجاقک را دنبال می کند و در نهایت بالای 
نامی که قبلا تایپ کرده اید قرار می گیرد.

تنظیمات انیمیشن لایه را مخفی کرده و سپس با فشار دادن کلید Home به ابتدای زمان انیمشین باز گردید.

:Motion Blur اضافه کردن افکت

77. در این مرحله می خواهیم حالت افکت حرکتی Blur را به تعدادی از لایه ها اضافه کنیم. افکتی که شی در حرکت حالت  
تار شدن پیدا می کند.

در پانل Timeline وضعیت motion blur را برای تمام لایه ها به جز لایه credits و pondbackground فعال نمایید. 
حال وضعیت motion blur آن ها را با کلیک درون کادر مربوط به motion blur انتخاب نمایید.

78. روی زبانه credits در پانل Timeline کلیک کرده و وضعیت motion blur را هم برای هر دو لایه فعال نمایید.

 Enable فعال نمایید. سپس روی دکمه credits را برای motion blur باز گردید. حالت Pond_Title_Sequence 79. به زبانه
Motion Blur در بالای پانل Timeline کلیک نمایید تا motion blur در پانل Compostion قابل مشاهده باشد. پروژه را در 

حالت پیش نمایش RAM Preview بصورت کامل مشاهده کنید. در نهایت پروژه را ذخیره نمایید.

<<تصویر در صفحه بعدی
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81. در کادر )Export As Adobe Flash Professional )XFL روی دکمه Save کلیک نمایید. تبدیل پروژه ممکن است کمی 
زمان بر باشد. اگر نرم افزار فلش روی سیستم شما نصب است می توانید فایل ساخته شده را برای استفاده در نرم افزار 

فلش باز نمایید. <<پایان<<
<< درباره دریافت خروجی پروژه به فایل ویدئویی به طور کامل در پروژه های شماره 1 و 2 توضیحات داده شد.<<

:Adobe Flash Professional دریافت خروجی برای نرم افزار

80. اگر می خواهید پروژه افتر افکت خود را روی صفحات وب استفاده نمایید، ممکن است بخواهید ادامه کار را در نرم 
افزار فلش انجام دهید. شما می توانید پروژه خود را به فرمت XFL برای استفاده در نرم افزار فلش تبدیل نمایید. فرمت 

XFL لایه ها و داده های مربوط به فریم های کلیدی را حفظ خواهد کرد.
در پانل Project ترکیب Pond_Title_Sequence را انتخاب نمایید.

از منوی File > Export گزینه )Adobe Flash Professional )XFL را انتخاب نمایید.
در کادر تنظیمات Adobe Flash Professional )XFL( Settings گزینه Resize To و از فهرست Format گزینه FLV را انتخاب 

نمایید. روی دکمه OK کلیک نمایید.

<<موفق باشید<<

هر گونه سوال و مشکل خود را درباره این آموزش در سایت پرسش و پاسخ فرا گرافیک مطرح کنید.
http://forum.faragraphic.com
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